
Patterns
 
The following patterns may be selected for rectangles, round rectangles and ellipses. When first 
created, the pattern is Clear. If a color is selected, the pattern defaults to solid. A pattern takes on the 
item color, so if the color is red, the lines in the pattern will be red.
 



Dragging and Dropping 
      
To drag a label item from the Tool Palette onto the label, press the item button with the left mouse 
button, and hold it down while dragging the mouse cursor over to the label. (the mouse cursor changes 
to reflect the item you are dragging). Position the mouse cursor over the label and release the mouse 
button to drop the item. 
 
To cancel drag and drop, simply release the mouse button over anything other than the label area.
 



Tool Palette Selected Object Tools
 

 Select an item on the label and click this button to get the items property menu
 
Select an item on the label and click one of the arrow buttons to move it. If the Move All box is checked, 
the arrow buttons will move ALL ITEMS on the label
 

 Select an item on the label and click this button to delete the item. You will be asked for verification.



Text Item

 Text
 
The text item is a block of freeform text that can be placed anywhere on the label surface, and which has 
many properties to choose from, including font, color and rotation. 
 
Text Item Properties



Counter Item
 

 Counter
 
The counter item is an incrementing number which you can set the starting number for. This is good for 
serial numbers, for instance. You can also set the number of labels each number is printed on before 
increasing by one. The counter item can also have various fonts, colors and can be rotated.
 
Counter Item Properties



Graphic Item
 

 Graphic
 
A graphic item is a BMP (bitmap) or WMF (Windows Metafile) file. The graphic file is not stored in the 
Visual Labels database - only the file name and path. If you delete or change the graphic file, it will be 
changed in the label.
 
We strongly recommend 16 color, smaller ( less that 10K) image files.
 
Graphic Item Properties



Symbol Item
 

 Symbol
 
A symbol is basically a member of the WingDings font set, which is installed with all copies of Windows. 
The symbol item can be resized by selecting it and resizing it. There are quite a number of interesting 
symbols to select from:

 
 
Symbol Item Properties



Vertical Line Item
 

 Vertical Line
 
This is simply a vertical line which may be moved and sized. You may set the line thickness and line color 
as well.
 
Vertical Line Item Properties



Horizontal Line Item
 

 Horizontal Line
 
This is simply a horizontal line which may be moved and sized. You may set the line thickness and line 
color as well.
 
Horizontal Line Item Properties



Round Rectangle Item
 

 Round Rectangle
 
The round rectangle item is similiar to the rectangle item, except it has rounded corners. It can be moved 
and sized to any round rectangular shape, and may have various colors, line colors, line thicknesses and 
patterns.

 
Round Rectangle Item Properties



Rectangle Item
 

 Rectangle
 
The rectangle item can be moved and sized to any rectangular shape, and may have various colors, line 
colors, line thicknesses and patterns.
 
 
Rectangle Item Properties



Ellipse Item
 

 Ellipse
 
The ellipse item can be moved and sized to any elliptical shape, and may have various colors, line colors,
line thicknesses and patterns.
 
Ellipse Item Properties



Image Dialog
 
This dialog helps you browse your computer for graphics files (BMP, WMF) that you can use. As you 
highlight an image, it is shown in the box to the right.
 



Symbol Dialog
 
 
You can select the symbol you wisth to use from this dialog. You may also set the color of the symbol 
using a standard Windows color dialog.
 



Set Rotation Dialog
 
With this dialog you can set the rotation or angle of the text from 0 (normal) to 359 degrees.
 



Counter Dialog
 
The counter dialog asks for the starting number - any number you like, and how many labels to print for 
each number before moving to the next number.
 
 



Counter Item Properties
 
Counter Values Set the starting number and repeat values with the Counter Dialog
Font Set the font for the counter using a standard Windows font dialog
Font Color Set the font color using a standard Windows color dialog
Rotation Set the font rotation (angle) using the Set Rotation dialog
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 



Graphic Item Properties
 
Image File Select the BMP or WMF image file with the Image Dialog
Stretch to Fit If true, the image will stretch to fit the size of the item
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 



Symbol Item Properties
 
Symbol Select the symbol to use with the Symbol dialog
Color Select color using the standard Windows color selector
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 



Horizontal Line Item Properties
 
Line Color Select line color using the standard Windows color selector
Line Thickness Select line thicknesses from one to ten points
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 



Vertical Line Item Properties
 
Line Color Select line color using the standard Windows color selector
Line Thickness Select line thicknesses from one to ten points
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 



Ellipse Item Properties
 
Color Select inside color using the standard Windows color selector
Line Color Select line (outside) color using the standard Windows color selector
Line Thickness Select line thicknesses from one to ten points
Pattern      Select solid, transparent, or one of six other patterns.
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 
 
 



Round Rectangle Item Properties
 
Degree of Rounding Sets the rounding percentage of the four corners
Color Select inside color using the standard Windows color selector
Line Color Select line (outside) color using the standard Windows color selector
Line Thickness Select line thicknesses from one to ten points
Pattern      Select solid, transparent, or one of six other patterns.
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 



Rectangle Item Properties
 
Color Select inside color using the standard Windows color selector
Line Color Select line (outside) color using the standard Windows color selector
Line Thickness Select line thicknesses from one to ten points
Pattern Select solid, transparent, or one of six other patterns.
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 
 



Text Item Properties
 
Text Type in the text for the item
Font Set the font for the item using a standard Windows font dialog
Font Color Set the font color using a standard Windows color dialog
Rotation Set the font rotation (angle) using the Set Rotation dialog
 
Send to Back Places the item behind all other items
Bring to Font Brings the item to the front of all other items
Center Centers the item in the middle of the label
Center Vertically Centers the item vertically in the middle of the label
Center Horizontally Centers the item horizontally in the middle of the label
Delete Deletes the item from the label (you will be prompted first)
 
 



Tool Palette Label Items
 
Text Rectangle
 
Ellipse Round Rectangle
 
Horizontal Line Vertical Line
 
Graphic Counter
 
Symbol
 
 
You may drag and drop any of these label items onto the label surface.



The Tool Palette
 
The Tool palette is a floating window that contains two sections. The first section is the Label Items 
section. These buttons represent items that can be dragged and dropped onto the label.
 
The second section is the Selected Object section, which contains buttons for moving, deleting or 
changing the properties of the selected item
    
The button at the upper right corner with an up arrow and a down arrow can be clicked to close or open 
the Tool Palette window. When closed, only the title bar remains visible.



Creating a New Label 

Click on New Label from the File menu, or on Clone Label from the Label menu to create a new label. 
 
If you clicked on Clone Label, you will be asked if you wish to 'clone' the current label. If you choose 
Yes, a new label will be created that is exactly the same as the current label, with the description 
changed    to 'Copy of ' and the name of the current label.
 
If you clicked on New Label, you are first asked to select a Label Template. (see Selecting a Label 
Template ).    A label template describes various attributes of the physical label, including its width and 
height, number across and number down, size of the paper, margins, etc. Visual Labels includes a large
database of predefined Avery brand labels organized by their Avery numbers. You may select one of 
these predefined templates, or you may create a new template for a type of label that is not on the 
template list.
 
Once you have selected a label template, the label area on the screen (a white rectangle or ellipse) will 
change to reflect the shape and size of the label template, and will be blank. The next step is to add 
label items to the label. To do this, you simply drag and drop items from the Tool Palette onto the label. 
Once an item is dropped onto the label, it can be selected by clicking on it. When an item is selected, it 
will have 'handles' around it for moving and resizing. Example:

 
You can also change the properties of the item (color, font, etc) by clicking on it with the right mouse 
button, or by clicking the properties button on the Tool Palette .
 
When you create a new label, or make changes to an existing label, the Save and Cancel buttons 
become visible. Press the Save button to save your changes to disk. Press the cancel button to cancel 
any changes. (for a new label, the cancel button cancels the creation of the label as well).

 
See Tutorial for an example of creating a label.



Tutorial
 
We will describe here how we created the example 3.5 inch disk label.
 
Click on New Label from the File menu. 

The Select Label Template dialog comes up.
 
Find and select Avery 5196 3-1/2" Diskette - White.    Press OK.
 
You should now have a blank 3.5 inch label on the main screen.
 
Now drag and drop a Text item onto the label - place it at about the middle of the label and about 1 inch 
down.
 
Select the text item by clicking on it with the left mouse button. You will see handlebars around it. 
Handlebars look like this:

 
Bring up the text item's property menu. (You can bring up an item's property box by clicking on the item 
with the right mouse button, or by selecting the item and clicking on the properties button on the Tool 
Palette.) Select Text from the menu. A dialog box will ask you to type in the new text. We typed in "Visual 
Labels". Now bring up the properties menu again and select Font. A Font Dialog box will come up.    We 
selected "Times New Roman", "Bold Italic", "22 points" and a color of dark blue. You may have to move 
the text item again to get it centered in the label.

 
You can follow this same procedure to place the other text items on the label, setting the font and text 
as appropriate with the properties menu.
 
The "New" text item has one more step. Choose Rotation from the properties menu. The Set Rotation 
Dialog will come up. Select a rotation angle of 45 degrees.
 
There are two symbol items. One is a small Windows symbol, the other a small telephone. For each of 
these, drag and drop a symbol item from the Tool Palette. the Symbol Dialog will come up, and you can 
select the appropriate symbol to be placed on the label.
 
Next drag and drop a rectangle item from the Tool Palette onto the label. From its property menu, select
Color and set it to green. Now select a counter item from the Tool Palette. Dag and drop it inside of the 
green rectangle. When the Counter Dialog comes up, set the properties to 2000 for the starting number,
and 1 for the number of repeats. Select the property menu and set its Color to white.
 
Finally, drag and drop a round rectangle item onto the label. Size and position it so that it covers the 
other items on the label. (you may have to move some of the other items around). Select Color from the
properties menu, and choose a light yellow. With the round rectangle selected, bring up the properties 
menu and press Send to Back. 
 
Press Save, and you are done!
 
Hint: While designing a label, you might find that because one item is in front of another you cannot 
select the 2nd item. All you need to do is send the 1st item to the back, and the 2nd item will be 
selectable. You may have to click outside of the label area to de-select all items, and then try to select 



the item you want to work with.
 
 
 
 
 
 



Selecting a Label Template
This screen displays a database of Avery and user-defined label templates. Each label record includes 
the complete technical specifications for that label.
 
You cannot change the Avery label specifications, but you can add and edit user-defined label 
templates.
 
New: Click the New button to add a user-defined label template. In the Description field, give the 
template any name you want, e.g., My First Template. Click Save to save your new label.
    
Edit: Click the Edit button to edit the specifications for any user-defined label template.
    
Delete: Click the Delete button to delete a user-defined label template.
 
Click the OK button to accept your selection and return to the previous screen.
 
 



Deleting a Label
 
Click on Delete button on the Label menu to delete the current label. You will be asked to confirm the 
deletion. Once deleted, a label cannot be recovered.



Printing Labels
 
Click Print on the File menu to print a page or pages of the current label. A Windows Print Dialog then 
comes up, where you should fill in the # of copies (pages of labels) that you want. Press OK to print, or 
Cancel to not print.
 
 
 
 



Print Setup
 
Click Print Setup on the File menu call up the standard Windows printer setup dialog. 
 
 
 



Previewing Labels
 
Click Preview on the File menu preview a single page of the current label. The preview will show what a
page of labels will look like once printed. (note: if you do not have a color printer, the labels will be 
printed in shades of black and white)
 
Click the magnifying glasses to zoom in or out. 
 
Click the page buttons to make the width of the page fit into the preview, or to display the full page. 
 
 
 
 



Select Specific Labels
You may want to print only certain labels on a sheet, and exclude others. For instance you may want to 
print only the first three labels on a sheet. 

The Select Specific Labels dialog box lets you do just that. The dialog presents you with a 'checklist' 
representing all of the labels on a single sheet of the current label design, and refers to the labels by 
their ROW and COLUMN, just like a spreadsheet. On a label sheet that had 2 across and 3 down, for 
instance, the first label would be referred to as "Row 1, Column 1", and the last label would be referred 
to as "Row 3, Column 2". 

Both the Print and Preview will skip any labels that are not checked, so you can easily test if you have 
selected the label position(s) that you really want to print. 

Once you have selected specific labels to include/exclude using the Select Specific Labels dialog, both 
the Print and Preview will continue to include/exclude these labels until you change the setting 
otherwise.

To start printing all labels on each sheet again, click the ALL button and press OK.

WARNING: AVERY SPECIFICALLY WARNS AGAINST RUNNING LASER LABELS THROUGH 
YOUR LASER PRINTER MORE THAN ONCE, AS THIS COULD RESULT IN PAPER JAMS. 



Main Menu Options
 
File

Select Label    Click here to select a different label
New Label Click here to create a new label
Rebuild Indexes Click here to rebuild the Visual Labels indexes
Print Labels Print a page of labels
Preview Preview the labels
Select Specific Labels Select specific labels to print/exclude for each sheet
Print Setup Setup the Windows printer for your labels

Label
Delete Label Delete the current label
Clone Label Make an exact copy of the current label
Configure Label Set the dimensions of the label and label page.

 
Help

Contents Displays the main page of the help file
About Displays an about box for the program



Selecting an Existing Label
 
Click on Select Label from the File menu    to bring up the Select Label screen. This screen presents a 
list of already defined labels. Select one from the list and press OK to use it. 
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Help Notes
 
Visual Labels for Windows provides three levels of on-line help:
 
For program-wide help, click on Contents on the Help menu.
 
For screen-specific help, click on the Help button and the Visual Labels help topic for the current screen
will be displayed.    
 
For help on a specific screen object, click on the Mouse Help button (the button with a question mark), 
and your mouse pointer turns into a question mark. Then, click on any screen object to display pop up 
help for that object.        
 
If you still have a question after consulting these three levels of help, please contact us for technical 
support.
 
 
 
 
 



Technical Support
 
Visual Labels includes an extensive Help system. Before contacting us for technical support, please 
check Visual Labels' Help system first to see if it contains the answer to your question.
 
If Visual Labels' Help system does not contain the answer to your question, please feel free to contact 
us.If at all possible, we prefer to receive technical support questions by email, fax, or regular mail. We 
have found that writing the question down often produces a clearer explanation of the problem. 
 
For technical support, please contact us any of the following ways:

· email rkssoft@erols.com 
· fax 703-534-4358
· mail RKS Software, Inc., 3820 N. Dittmar Road, Arlington, VA 22207
· phone 703-534-1726

 
 
 
 



Introduction
 
Visual Labels is a professional quality label (and business card) design and printing program. Here are 
some of its features:

· True drag and drop, WYSIWYG label design, with instant print preview
· Design labels with:

* Text: placed anywhere on the label,    using any font, any color, and rotate text to any angle
* Shapes: boxes, ovals, lines and rounded rectangles with any color, pattern,    line thickness 

and line color
* BMP or WMF graphic files
* Counters: Numbers that increment with each label printed (can be used for serial numbers)

· Can be used with most Laserjet or Inket printers, including color printers
· Supports sheets of Letter, A4 and A5 labels 
· Includes a predefined database of Avery label and Business card    templates, or you can create 

your own  
 
Visual Labels for Windows is designed to meet all your label and business card design needs. But 
nothing is perfect. If you have a suggestion for improving Visual Labels, please let us hear from you.
 
Getting Started
Technical Support 
Help Notes 
 
 



Getting Started
 
System Requirements
 

· IBM-compatible personal computer.
· Hard disk with at least 2 MB available.
· Mouse or equivalent pointing device.
· Microsoft Windows 95 or Windows 3.1.

 
Installation
 

· Visual Labels comes with an installation program named INSTALL.EXE. Simply run 
INSTALL.EXE and answer the prompts, and Visual Labels will be installed in the directory of your
choice.     

· Visual Labels will be installed in the RKS Software program group by default, but you can change 
this during the installation.

 
Help

· Visual Labels includes extensive on-line help. Select Contents from the Help menu, or click on 
one of the help buttons to get answers to any of your questions.

 
Technical Support

·       Technical support is available by phone, fax, email, and regular mail. Please contact us with 
any questions the on-line help does not answer.

 
 
 
 



Rebuild Indexes
 
Visual Labels keeps your records properly sorted automatically.
 
This sorting process is referred to as indexing.
 
Power outages, power surges, brownouts (voltage reductions), or other power-related problems can 
corrupt index files. If your records ever seem to be out of sequence, use this feature to rebuild the index
files.
 
 
 
 



Add or Edit Label Template
 
The Add or Edit Label Template screen lets you describe to Visual Labels the physical characteristics of 
your template.
 
You may select units of 1000's of an inch, or millimeters.
 
Description

Please enter a unique description for the label template
Label Width

The width of the physical label
Label Height

The height of the physical label
Horizontal Pitch

The distance from the left edge of a label, to the left edge of the label next to it
Vertical Pitch

The distance from the top edge of a label, to the top edge of the label below to it
# Across

The number of labels in each row
# Down

The number of labels in one column
Left Margin

The distance from the left edge of the page to the left edge of the first label
Top Margin

The distance from the top edge of the page to the top edge of the first label
Paper Size

Select from the list of supported paper sizes
Label Shape

Select Rectangle, Round Rectangle (most common), or Round
 
 
The following diagram attempts to explain visually the various label dimensions:

 
 
 
 
 





Label Item Properties
 
Each item on the label has a properties menu that can be accessed by either:
 

· Clicking on the item with the right mouse button
· Selecting the item and clicking the properties button on the Tool Palette

 
Click below to find the properties for a specific Label Item:
 
Text Item Properties
Rectangle Item Properties
Ellipse Item Properties
Round Rectangle Item Properties
Vertical Line Item Properties
Horizontal Line Item Properties
Symbol Item Properties
Graphic Item Properties
Counter Item Properties



Changing The Design of a Label
 
Items on the label can be selected by clicking on them. When an item is selected, it will have 'handles' 
around it for moving and resizing. Example:

 
You can change the properties of the item (color, font, etc) by clicking on it with the right mouse button, or 
by clicking the properties button on the Tool Palette 
 
You can also change the label template by clicking on Configure Label from the Label menu. 

 
When you make changes to an existing label, the Save and Cancel buttons become visible. Press the 
Save button to save your changes to disk. Press the cancel button to cancel any changes. 
 
 




